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the mizzou store

MIZZOU PUBLISHING
university of missouri student center
911 e. rollins st.
columbia, mo 65211
573.882.8567
mizzoupublishing@missouri.edu
https://www.hightail.com/u/mizzoupublishing
www.themizzoustore.com
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pricing.
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IMPRESSION
Black & White
Blank
Color
Cover
Single-sided cover

... [ $.07 ]
... [ $.05 ]
... [ $.15 ]
... [ $1.00 ]

Outside front and back full color

Double-sided cover

... [ $1.25 ]

Printed inside and out, front and back full color

Laminate cover

... [ $2.00 ]

Printed inside and out, front and back full color

$.01 additional per sheet charge for 28# papers
$.02 additional per sheet charge for 32# paper

EXAMPLE BOOK PRICING

150 total pages (140 b&w, 10 color), single-sided cover
140 total pages [ $.07 ]
		
140 (b&w pages) x $.07 = $9.80
10 color pages [ $.15 ]
		

10 (color pages) x $.15 = $1.50

Single-sided cover [ $1.00 ]
		
1 (cover) x $1.00 = $1.00
Total Price Per Book
		
$8.40 + $1.40 + $1.00 = $12.30
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additional pricing.
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OPTIONAL SERVICES
Set-up/File Conversion
Cover Design/Content Layout
Scanning/Miscellaneous Help
Written Review of Content and Cover files
Consultation on Book Layout/Design (1hr)
ISBN, Barcode & Registration
Consignment (6 Months)
Professional Headshot Photograph
Additional Proofs*

... [ $10 ]
... [ $30/hr ]
... [ $30/hr ]
... [ $15 ]
... [ $30 ]
... [ $25 ]
... [ $20 ]
... [ $65 ]
... [ Cost of Book ]

If you provide files other than PDFs you will be charged the set-up fee.
An inspection proof will only be provided if 10 or more copies are ordered. Expect your
first proof within 1-2 business days after receiving your files. Additional proofs will be
issued at the cost of your final book.

PUBLISHING KITS
Ask about our publishing kits to save on bundles of the services
listed above.

QUANTITY ORDER DISCOUNTS
10-24 books
25-49 books
50-99 books
100-349 books
350+ books

... [ 10% ]
... [ 15% ]
... [ 20% ]
... [ 25% ]
... [ 30% ]

UNIVERSITY DEPARTMENT PRICING
If you have a university sponsored or affiliated project please
contact Mizzou Publishing to learn more about our academic
pricing. Additional quantity discounts do not apply to
department orders.

SHIPPING
We are able to ship orders via UPS or FedEx. Standard rates
apply and will be communicated at the point of purchase.
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PUBLISHING KITS
TIER ONE		

$49.00 a $75 value

1.

ISBN, registration and barcode – ISBN listing Mizzou Publishing as the
publisher. (The author still retains ALL rights and responsibilities.)

2.

Book Setup (file converted to PDF, creation of basic cover and addition
of barcode if needed (using templates by Mizzou Publishing staff)

3.

The Mizzou Store Consignment.
i. Minimum of 6 months on our shelves for sale.
ii. Posted on themizzoustore.com for online purchase.
iii. 75% of Net Retail goes to the author.

4.

Written review of your content and cover files with suggestions and
feedback provided on the layout/design to create a more polished/
professional book.

TIER TWO		

$99.00 a $150 value

1.-4. Same as above.
5.

Printed proof and a looseleaf copy for review and consultation

6.

One hour consultation to discuss, review and provide suggestions on
your book before printing.

TIER THREE		

$149.00 a $225 value

1.-6. Same as above.
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7.

Professional headshot photograph taken by The Mizzou Store
photographer

8.

100 bookmarks or 50 postcards (designed by Mizzou Publishing – ask
to see examples)

PUBLISHING KIT: BREAKDOWN & GLOSSARY
/ TIER ONE

/ TIER TWO

/ TIER THREE

1.

ISBN, registration and barcode.
An ISBN, or International Standard Book Number, is a unique number that
is assigned to a book so that it may be easily sold in bookstores, to libraries,
or through online book retailers.
Having a barcode for your book, along with an ISBN, will allow your book to
be made readily available for purchase, and will give it a more professional
publication quality.

2.

Book Setup
A service needed to prepare your book for printing (file conversion to PDF,
creation of basic cover and addition of your ISBN barcode if needed, using
templates by Mizzou Publishing staff)

3.

The Mizzou Store Consignment.
The Mizzou Store website is a great way to sell your book. Selling made
easy with the hassels of money handling and shipping taken care of. Simply
when marketing your book direct customers to our website and the rest is
taken care of by us. 75% of the net retail goes to the author, paid quarterly.

4.

Written review of your content and cover layout.
The layout and design of a book will attract the reader before they read
a single word of the content, so this aspect of your book is of utmost
importance. Our experienced design team and staff will be able to offer
valuable critiques to ensure that your book is professionally designed and
attractive to customers.

5.

Printed proof and a manuscript copy
A proof is a valuable assets in the printing process, along with a looseleaf
manuscript style copy will make the editing process a breeze.

6.

One hour consultation to review content before printing.
Mizzou Publishing has published books for hundreds of authors over
our long history. All the knowledge we’ve gained regarding the printing
and publishing process will be at your disposal through a one-on-one
consultation.

7.

Professional headshot photograph.
Professional author headshots can be found in nearly every bestseller in the
country. Having an author bio and photo gives your book a more polished
aesthetic, and allow your readers to connect with the author more easily.

8.

100 bookmarks or 50 postcards.
Custom-designed bookmarks or postcards are a simple, yet incredibly
effective way to market your book. Having promotional materials branded
with your book makes it easier for you to promote it.
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introduction.
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SELF PUBLISHING OVERVIEW

Mizzou Publishing can print and bind a paperback book within
minutes. This service is ideal for self and custom publishing
projects. Authors can have physical copies in quantities as few
as 1 or as many as desired in a matter of days. Printing ondemand allows authors to order smaller quantities for proofing
and to minimize on-hand stock.

THE ADVANTAGES

Consumers - shorter turnaround for orders and reduced costs.
Bookstores, Libraries, and Other Retailers - Sell more titles
without the extra inventory; capture the growing selfpublishing market.
Publishers - On-demand printing should be a critical piece of
your digital strategy. Helps avoid out-of-stocks and eliminate
returns.
Authors - Order your book in any quantity, even on multiple
occasions if necessary.
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getting started.
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Typical novels aren’t the only thing that can be printed – the
possibilities with print on demand machines are endless! We
invite, and encourage, you to explore the many options and
come up with something creative and fun. Below are some
examples of types of projects that can be made:
• Publishing your very own novel.
• Producing a professional thesis, dissertation or custom
portfolio.
• Creating a book of poetry.
• Assembling favorite children’s stories and artwork for a
lasting piece of memorabilia.
• Preparing a recipe book to use as gifts during the holidays
or for a fund-raiser.
• Compiling a photo album of friends and family.
• Designing and printing a custom journal to document
your stories.
The ideas are never-ending. Continue reading to learn more
about what Mizzou Publishing has to offer and how you can
take advantage of it. In the end, this How-To Guide will be your
number one resource for successfully getting your very own
book printed.
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the process.
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1. You have an idea.
2. Choose a book size and then write (preferably type) it out.
3. Insert pictures, page numbers, headers, etc., if necessary.
(Check out our publishing kits in the pricing section for
professional help)
4. Design a cover yourself, or choose one from page 26 of this
book/have us design a custom cover for you. If you choose a
cover, tell us the title, author, colors and any pictures you want
to use, and we’ll take care of the rest!
5. Export the content (and cover files) to .PDF (For help with this
contact us at mizzoupublishing@missouri.edu).
6. Submit the content and cover files to us, in person, over
email, or Hightail uplink and you’re done (for now)!
7. A member of the Mizzou Publishing staff will sit down, create
the cover (if needed) and ensure the files have been set up
correctly.
8. A copy will then be printed at Full or Discounted unit price
depending on the quantity ordered. if 10 or more are ordered a
free proof will be provided.
9. We’ll contact you and at this time you can come review your
first copy. If changes need to be made, fix them, and we’ll print
another proof. If no changes need to be made, we’ll begin to
print the rest of your order.
10. Enjoy your book(s)!
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the setup.
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WHAT WE NEED FROM YOU
You will end up submitting two files to us:
A CONTENT file and a COVER file.
Please name the files:
Last Name_Abv. Title of Book (Width x Height)_Cover
Last Name_Abv. Title of Book_Size of Book (Width x Height)_Content

Acceptable file formats: Files other than .PDF will be charged a conversion fee.
Portable Document Format (.PDF)
Packaged InDesign Document (.INDD)
Word Document (.DOC, .DOCX)
You can bring your files directly to us on a USB Flash Drive.
Do not email us the files, typically files are to large to transfer
through email and get lost. To upload files go to our Hightail
uplink.
https://spaces.hightail.com/uplink/MizzouPublishing

BEGINNING THE SETUP
To most efficiently and successfully create your project we
suggest you follow the steps below. Each step will be further
explained in the next pages.
1. Choose the size of your book
2. Create your content file
3. Fill in all of your content—including pictures, headers,
page numbers, etc.
4. Create your cover file*
5. Export your files as PDFs
*Optional if you want us to create a cover file for you
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1. CHOOSING YOUR BOOK SIZE
Typical novels are sized between 5”x7” to 6”x9”
We can trim a book to be any size limited for:
- Portrait orientation 20 - 750pgs:
*max width 8.25”
max height of 10.5”
- Landscape orientation 20-750pgs: max width of 9.125”
*max height of 8.25”
*books requiring full page bleed will need to be smaller

Spine

10.5”

8.25”

Smallest

Largest

4”

Spine

4”
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Spine

8.25”

9.125”

12 12 12 12 1 1

1 1

2. CREATING YOUR CONTENT FILE
Now that you have chosen your overall book size, it is time
inside
inside
inside
to create
your inside
content file.
It is important
to start with your
front front
back back
content because your cover size will depend on the final
content page count.
Start by opening either Microsoft Word or InDesign (or your
preferred word processing/layout software).

2 2 11 11

2 2 11 11

Numbering is strictly for illistrative purposes

PAGE 1 (CONTENT FILE)

3 3

4 45 5
6 67 7

2 23 3

11 11
10 10

8 89 9
PAGE ?? (FINAL EVEN
NUMBERD PAGE OF
CONTENT FILE FACING
IN-SIDE BACK COVER)

10 10
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For Microsoft Word:
Go to “Page Layout” > “Size” > “More Paper Sizes...”
A dialog box should appear giving you the option to type
in your own custom size.
Next, click on the “Margins” tab. Next to “Multiple Pages”
change the drop-down menu to “Mirror Margins.” This will
allow you to have inside and outside margins instead of left
and right. We recommend having at least .5” margins all the
way around and a .75” on the spine edge. Make sure the
drop down for “Apply to” is set “Whole document.”
For Adobe InDesign:
At the opening screen make sure the “Facing Pages” box is
checked. Below that, change your height and width to the
overall size of your book. Next, change the margins to your
preferred widths (we suggest at least .75” margins). Finally, if
you plan on having any color near the edges of the pages,
add at least a .125” bleed on the outside, top and bottom.
Select “OK” and add as many pages as you need.
After that, you are ready to start typing out your content
and inserting pictures, page numbers, chapter headings,
etc. Just make sure you are working with individual pages
and not spreads (two pages connected together). When
we go to print your content files we print them as single (or
double-sided pages), not spreads.
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back
back

1
1

12
12

1
1

OUTSIDE BACK
COVER

OUTSIDE FRONT
COVER

2
2

11
11

INSIDE FRONT
COVER

SPINE

de
ck
de
ck

When your content is completed, it’s time to create your
separate cover file. The cover file consists of your front cover,
book spine and back cover—all connected together. The
height of your cover will be the height of your book. To find
your cover file width you will use the formula below.

SPINE

12
12

CREATING YOUR COVER FILE

PAGE 1

PAGE 2

INSIDE BACK
COVER

Cover Width = 2X + .0327 + (Thickness)*Y
X = Overall book width
Thickness
= (.0046) white 24lb paper
		
= (.0050) matte 28lb paper
		
= (.0052) matte 32lb paper
Y = Total number of pages (pdf count) divided by 2
Example: A 200 page book that is 6” x 9” overall.
= 2(6”) + .0327” + (.0046”)*(200/2)
= 12” + .0327” + .46”
= 12.4927”
Final cover file document size will be 12.4927” wide by 9” tall.

2 3
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For Microsoft Word:
Start with a new document. Go to “Page Layout” > “Sizes” >
“More Paper Sizes.” Change the document to be the height
of your overall book size and then the width to the number
you found by using the formula above. Next, go to the
“Margins” tab and change all the margins to 0”. Finally find
“Columns” next to “Page Layout” and click “More Columns”
at the bottom. Change the number of columns to two (2),
“Width” to your overall book width, and “Spacing” to the
number found by solving
(.0327 + (Thickness)*Y). Finally check the box that says
“Equal column width” and click “OK”.
For Adobe InDesign:
Create a new document. At the dialogue screen change
“Height” to the overall height of your overall book size.
Change “Width” to the number you found by solving the
formula on the page to the left. Change the number of
columns to two (2) and change the gutter to the value
found by solving (.0327 + (Thickness)*Y) from the original
formula. Next, make the margins all equal 0” and add a
bleed of at least .125” on all sides. Select “OK” and you’re
ready to go.
You now have a document that consists of three (3) boxes.
The left box will be your back cover, the middle box (the
gutter, or space between columns) will be your spine, and
the right box will be your front cover.
If you want to create a double-sided cover, duplicate your
front cover, but know that the left box is now your inside
front cover, and the right box is your inside back cover.
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EXPORTING YOUR FILES TO PDF
When you are finished creating both your content and cover
files you are now ready to finish them by exporting or saving
them as PDFs.
For Microsoft Word:
Go to File > Save As > Adobe PDF.
For Adobe InDesign:
Go to File > Export > Adobe PDF (Print). When the dialogue box
appears, change the Adobe PDF Preset to “High Quality,” and
make sure “Spreads” is NOT checked. Finally, go to the “Marks
and Bleeds” tab and check “Crop Marks”, “Page Information,” as
well as “Use Document Bleed Settings.” The bleed sizes your
entered in the document settings should fill in the faded boxes.
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CONTENT TEMPLATES
Select content templates for Microsoft Word are available
on our website. You can access these by visiting: http://
www.themizzoustore.com/ then finding “Self Publishing”
under the “Books & Supplies” tab. Then under the
“Resources” tab select Templates. There is also a form
available to request a custom-sized content template for
Microsoft Word or Adobe InDesign.

COVER TEMPLATES
If you would like to not have to deal with the hassle of
creating your own cover, a member of Mizzou Publishing
can create a custom cover ($30.00/hr.) or give you the
option to choose from any of the templates below ($10.00).
Just provide us with the necessary text, colors and/or
graphics and we’ll take care of the rest!

1

2
TITLE OF
THE BOOK

Author

Title of the book

3

Author of the Book

4

TITLE OF THE BOOK

TITLE
of book
AUTHOR

AUTHOR OF THE BOOK
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COLOR PALLET
When selecting to use one of our cover templates, you also
have the option to choose any set of colors you like.
If you’re requesting specific colors, make sure you provide us with the CMYK
color codes.
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paper options.
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We offer five varieties of papers found below. The most
common paper we use is the 24lb white paper (used mainly
for typical novels or other text-heavy books) followed by our
28#/32# papers (great for image-heavy books, magazines and
portfolios).

32# WHITE PAPER***
(120 g/m2), (.0053”)

28# WHITE PAPER**
(105 g/m2), (.0050”)

24LB WHITE PAPER
(90 g/m2), (.0046”)

24LB CREAM PAPER*
(89 g/m2), (.0046”)

20LB PERFORATED PAPER*
(75 g/m2), (.0040”)

*additional $.01 per sheet
**additional $.02 per sheet
***additional $.03 per sheet
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ISBN stands for International Standard Book Number. This
number is used to identify books in the book market; it is an
internationally recognized identifier.
An ISBN is used to identify specific titles or editions of books
created by a publisher. Bookstores, libraries and distributors all
use the ISBN to identify a specific version of a book.
An ISBN is typically used if you plan on selling your book in
retail stores or online (Amazon.com, etc.).
Getting an ISBN and/or barcode on your project is as easy as
coming to us with that request. Simply tell us how much you
are intending on selling your book for, and we will register the
ISBN and place it within your book. If you require a barcode as
well we will place that on the back cover, or where you prefer.
Here is a sample of what the barcode and ISBN will look like:
50000

9 781616 000035

Refer to page 9 of this How-To Guide for further
pricing information.
Want your book on the shelves of the Mizzou Store? Contact us
for more information regarding our consignment options.
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resources.
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COPYRIGHT INFORMATION
Just as we want to be sure no one illegally uses materials you
have created, we also want to protect the intellectual/creative
property of others. Images, text and music are all covered
under copyright law – if you intend to use materials you did
not create yourself you must secure permission to do so. Most
of the time you will be asked to pay a royalty fee for its use.
This price can vary widely depending on the material, the type
of project it is being used in, its availability for re-sale through
other channels, and how many copies you intend to distribute.
The price can be a per copy fee or it can be a flat rate fee.
An area that always surprises people is that material on the
internet is also copyright protected. Just because it is out
there for everyone to see does not mean anyone can use
the materials without permission. You should contact the
organization/business/individual and ask permission to use
their material.
Like the internet, just because an image is out for all to see
it does not mean the rightsholder has relinquished control
over its use. You should contact the painter/illustrator/
photographer/etc… to ask their permission.
There are many sites that tout they are ‘royalty free’ sites to get
images—this is true if you are only using that image for your
own personal use. Once you plan on distributing the image to
others you need to purchase a distribution license. The benefit
of these websites is that they have a great selection of images/
photos/designs to use and they make purchasing the licenses
easy.
Once your work is in a tangible format it is considered
copyrighted. If you wish to further legitimize your copyright
claim you may choose to register your work with the U.S.
33

Copyright Office. There is a fee involved with registering
your claim, the minimum being $35.00 – which is
something you will do through the U.S. Copyright Office.
University BookStores are not liable for securing any
copyright by or for you and your work. It is the customer’s
responsibility to ensure all copyright laws are followed and
no rights are infringed upon.

COPYRIGHT RESOURCES
Resources to aid in the copyright process:
• www.copyright.gov
• www.copyright.com
• www.copyrightalliance.com
• www.permissionsgroup.com
If you need assistance in learning how to write/design/
market your book we have put together a list of resources
which you may find helpful.
• http://www.selfpublishingresources.com/
• http://www.self-pub.net
• http://www.writersmarket.com/
• http://www.bowkermanuscriptsubmissions.com/
• Indie Publishing: How to Design and Publish Your
Own Book, by Ellen Lupton
• Dan Poynter’s Self-Publishing Manual: How to Write,
Print, and Sell Your Own Book, by Dan Poynter
• 2015 Writer’s Market, by Robert Lee Brewer
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TYPOGRAPHY
Choosing the right font and font size is very important for any
print project. First decide if you like the serif style or sans serif
better. Typically serif style fonts are used for longer passages
of text because the little lines, or “serifs,” help your eye create a
horizontal reading line. Sans Serif fonts form a very clean and
modern look. Examples are shown on the next page.
Typical books use a font in the 10-12 point range. You must also
be aware that each font is a slightly different size. As you can
see below, the sans serif font on the left (Arial) is slightly larger
than the serif font (Times New Roman) on the right—while still
having the same point value. Additionally, larger font sizes can
lead to more pages in your book/project.
The most important thing is that you like the font. Be sure the
size is easy/comfortable to read for you and the people who
will be reading it.
7 Point Font

Aa

Aa

7 Point Font

8 Point Font

Aa

Aa

8 Point Font

9 Point Font

Aa

Aa

9 Point Font

10 Point Font

Aa

11 Point Font

Aa

Aa 10 Point Font

12 Point Font Aa

13 Point Font Aa

14 Point Font Aa

15 Point Font Aa

16 Point Font Aa

17 Point Font Aa

18 Point Font Aa

Aa 11 Point Font

Aa 12 Point Font

Aa 13 Point Font

Aa 14 Point Font

Aa 15 Point Font

Aa 16 Point Font

Aa 17 Point Font

Aa 18 Point Font
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Serif Fonts

Times New Roman
Aa Bb Cc Dd Ee Ff Gg Hh Ii Jj Kk Ll
Mm Nn Oo Pp Qq Rr Ss Tt Uu Vv Ww
Xx Yy Zz 0123456789
Garamond
Aa Bb Cc Dd Ee Ff Gg Hh Ii Jj Kk Ll
Mm Nn Oo Pp Qq Rr Ss Tt Uu Vv Ww
Xx Yy Zz 0123456789
Rockwell
Aa Bb Cc Dd Ee Ff Gg Hh Ii Jj Kk Ll
Mm Nn Oo Pp Qq Rr Ss Tt Uu Vv Ww
Xx Yy Zz 0123456789
Bodoni MT
Aa Bb Cc Dd Ee Ff Gg Hh Ii Jj Kk Ll
Mm Nn Oo Pp Qq Rr Ss Tt Uu Vv Ww
Xx Yy Zz 0123456789

Sans Serif Fonts

Arial
Aa Bb Cc Dd Ee Ff Gg Hh Ii Jj Kk Ll
Mm Nn Oo Pp Qq Rr Ss Tt Uu Vv Ww
Xx Yy Zz 0123456789
Myriad Pro
Aa Bb Cc Dd Ee Ff Gg Hh Ii Jj Kk Ll Mm
Nn Oo Pp Qq Rr Ss Tt Uu Vv Ww Xx Yy Zz
0123456789
Helvetica
Aa Bb Cc Dd Ee Ff Gg Hh Ii Jj Kk Ll
Mm Nn Oo Pp Qq Rr Ss Tt Uu Vv Ww
Xx Yy Zz 0123456789
Franklin Gothic Book
Aa Bb Cc Dd Ee Ff Gg Hh Ii Jj Kk Ll Mm
Nn Oo Pp Qq Rr Ss Tt Uu Vv Ww Xx Yy Zz
0123456789
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ADDING PHOTOS, IMAGES OR GRAPHICS
When adding pictures to your project please follow these
simple guidelines to make sure your photos come out crisp
and clear.
Scan all images at 300dpi or higher
If using an image from the Internet:
• Choose one with at least a resolution of 500 pixels by 500
pixels.
• Do not make it larger than it already is (see below for an
example)
• Make sure it isn’t protected under copyright laws
Make sure there is enough contrast
• You don’t want the image to be too light or too dark. If
the image doesn’t have good contrast the colors can
blend and make them hard to distinguish.

GOOD

BAD
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final checklist.
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Proofread
Layout reviewed
Text and images are on proper pages
Fonts are easy to read
Margins are large enough
Cover and Content files are exported with a bleed if any
images or colors run off the page edge
Images are at 300dpi minimum
Chapter titles and sections are easy to distinguish and
match your table of contents
Overall layout and fonts have consistency
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